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DISCLAIMER

Whilst every effort has been made to ensure that the information
in this manual is accurate an d complete, no liability will be
incurred for errors and/or omissions made. Nixvue Systems
reserves the right to alter the specifications and features of the
hardware, software and firmware of the product described
herein at any time without prior notice.

No part of this manual can be reproduced, transmitted, stored in
a retrieval system or translated into any language in any form,
by whatever means, without the prior written permission from
Nixvue Systems Pte Ltd.

Nixvue Systems makes no warranties for d amages resulting
from corrupted or lost data due to mistaken operation or
malfunction of the hardware, software, firmware, PC card
adapter, computers and any other peripheral devices and
adapters.

TRADEMARK ACKNOWLEDGMENTS

Nixvue Digital Album is a regis tered trademark of Nixvue
Systems. CompactFlash is a trademark of SanDisk Corporation.
Microsoft, Windows, Windows NT, Windows 2000 are either
trademarks or registered trademarks of Microsoft Corporation in
the United States and other countries. Other name s and products
not mentioned may be trademarks or registered trademarks of
their respective countries .
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WARNING

Do not attempt to disassemble or modify any part of the
equipment, as there are no user -serviceable parts in these
devices. Repairs and maintenance should be conducted only by
qualified service personnel authorized by the dealer.

To avoid the risk of high-voltage shock, do not touch the
Docking Station if it has become damaged. Do not put your
fingers in contact with the insides of the docking port, as this
may damage the internal circuitry.

Stop operating the equipment immediately if it emits smoke or
noxious fumes. Also, stop operating the equipment if it has
been dropped or the casing is visibly damaged.

If such instances occur, check that the smoke emissions have
stopped, then unplug the power cord from the Docking Station
and send the unit to the closest Nixvue Support Centre for
diagnosis and repair.

Do not allow the equipment to come into contact with, or
become immersed, in water or other liquids. Do not allow
liquids to enter the interior. If the exterior comes into contact
with any liquids, wipe it dry with a soft, absorbent cloth. If
liquids or other foreign substances enter the interior of any
device, immediately turn off the power and unplug the power
cord.




PRECAUTIONS

On Safety

Should any solid object or liquid enter the device , unplug the
power and have it checked by qualified personnel before further
operation.

On Positioning

Put the Digital Album and Docking Station in a location with
adequate ventilation to prevent heat buildup, which may
shorten the operational life of the devices or cause battery
leakage.

Do not use, place or store the devices near heat sources, or in a
place subject to direct sunlight, excessive dust or mechanical
shock. High temperatures may also cause deformation of the
casing.

On Operation
Before connecting other components, be sure to turn off and
unplug the power first.

On Cleaning

Clean the exterior of the devices with a soft cloth. Do not use an
abrasive pad, scouring powder or solvent such as alcohol or
benzene.



PREVENTING MALFUNCTION

Avoid Strong Magnetic Fields

Never place the Digital Album in close proximity to electric
motors or other equipment generating strong electromagnetic
fields. Exposure to these may cause malfunction or corrupted
image data.

Avoid CondensationRelated Problems

Moving the equipment between hot and cold temperatures
rapidly may cause water condensation to form on the external
and internal surfaces. Avoid this by placing the equipment in an
airtight, resealable bag and letting it adjust to the temperature
change slowly before removing the bag.

If condensation occurs, stop using the Digital Album
immediately. Prolonged use will damage the equipment.
Remove the PC card adapter from the Digital Album and allow
four hours for the moisture to completely evaporate bef ore
resuming use.



1. BASIC SET-UP

INTRODUCTION

elcome to the Nixvue Systems Digital Album!

Nixvue's Digital Album is a palm-sized, portable
device designed for storing images taken by digital
cameras.

With an integrated high-capacity hard disk that can
store thousands of images, it allows you to download
pictures from your camera at the touch of a button.

These pictures are automatically organized into folders
and can be viewed on any PAL or NTSC television. The
Digital Album can also be directly connected to a
printer, thus eliminating the need for computers to print
hard copies. Advanced users can also connect the
Digital Album to a computer (via a USB port),
appearing as just another hard disk.

This flexibility allows you to concentrate an your
photography instead of worrying about the technical
aspects. The Digital Album has been designed to make
digital photography easier and more accessible to
everyone, novice and expert alike.



UNPACKING THE DIGITAL ALBUM

Check that the following iems are contained in the box:

e Digital Album Unit

e Digital Album Docking Station

e Compact Flash Type I PCMCIA Adapter
e Digital Album Carrying Pouch

e Remote Control Unit (with battery)

e Video and USB Cable

e 110/220V Auto-switching Power Adapter
e CD-ROM Software and User Manual



Installing the Batteries

Connect the wires of the Digital Album battery into the
slot inside the battery compartment at the rear of the
Digital Album. Next, insert the CR2025 battery into the
remote control.

When using the remote, point it at the remote sensor on
the front of the Digital Album. Under normal usage, the
batteries on the Digital Album should last for about 30
transfers (for a 32MB memory card) and the batteries on
the remote unit should last 12 months. When the remote
no longer operates the receiver, replace the battery.

CONNECTING THE EQUIPMENT

After unpacking the contents from the box, install the
system as follows:

1. Plug the video cable into the Docking Station
and then into the composite video-in port on the
television. Select the AV-video feed channel on
the television.

2. Plug in any other peripherals (printer to parallel
port, computer to USB port) if needed.

3. Put the rechargeable battery into the Digital
Album.

4. Plug the power adapter unit into the Docking
Station.
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5. Insert the Digital Album into the docking cradle.
It takes approximately 4 hours to fully charge the
battery in the docking cradle.

6. The Digital Album is now ready to be switched
on by depressing the ® button.

The Docking Station has no power switch, but it acts as
a battery charger for the Digital Album when it is not in
use.

BASIC USAGE

11



After taking the pictures with the digital camera,
remove the memory card from the camera, insert it into
the appropriate PCMCIA adapter and then slot the unit
into the PCMCIA compartment on the top of the Nixvue
Digital Album unit.

Push the ® button to power the unit, select the COPY
option and then push the button one more time to
transfer all the images from the memory into the Digital
Album. The LCD display will show the progress meter
advance as the transfer proceeds. All the image files in
the portable memory will be completely transferred,
thus freeing the memory card for storing other pictures.

To view the pictures, insert the Digital Album into the
Docking Station. Press the ® button once to switch on
the unit. The VIDEO ON option is automatically
selected. Push the button one more time to activate the
video on the TV. A detailed description of viewing
functions is explained in the following chapters.

PRINTING VIA PARALLEL PORT

The Digital Album has been designed to be able to print
its stored images directly on a printer, bypassing the
requirement of a computer.

Connect the printer cable to the parallel port at the rear
of the Docking Station. To start printing the images and
for more options, please refer to the File Menu - Print
section in Chapter 4 - Video Menu Functions.

12



COMPUTER CONNECTION (USB PORT)

The Digital Album has also been designed to connect
via a USB port to a generalpurpose computer. When
connected, the Digital Album is treated as an additional
hard disk.

This allows images on the Digital Album to be copied
out and edited or worked on. After they have been
modified / processed, the pictures can be transferred
back to the Digital Album for storage

13



To connect the Digital Album to a computer via USB,
follow these steps:

1. Turn on the computer.

2. Mount the Digital Album onto the docking
cradle, and then turn on the Digital Album. The
LCD panel will display the startup logo.

3. After the Digital Album has powered up,
connect the USB cable from the Digital Album to
the computer.

4. If this is the first time that you are connecting the
USB cable to the PC, the computer will prompt
you for the appropriate USB driver. Simply
insert the CD-ROM into the driveand follow the
instructions.

5. The computer will automatically detect the
Digital Album as an external hard disk.

IMPORTANT:

Do not attempt to use the USB port to link to the
computer when the Digital Album is set to display
video on the television set.

First power off the Digital Album unit then switch it on
again using the ® button, taking care NOT to activate
the VIDEO ON mode by pressing the button twice. You
can then safely connect to the USB port.

14



2. USING THE DIGITAL ALBUM

he Digital Album is a palm-sized, battery-powered
portable unit containing a hard disk and an LCD
user screen.

The Digital Album, shown here in its docking cradle,
has the following functions:

a. Copying from PCMCIA card to hard disk
b. Verifying last copied data

15



c. Video Mode selection
d. Power Off selection
e. Disk Space usage check

There are five buttons on the main Digital Album unit:

* Options

w Arrow Down

® Enter, Power On
A Arrow Up

D Contrast

MAIN MENU

To start using the Digital Album, press the ® button.
The unit will power up, simultaneously displaying the
Nixvue logo as the system powers up.

OIGITAL ALEUM

Depending on whether the unit is connected to the
docking station or not, the main menu will display the
following:

COPY

UERIFY . . .

if the Digital Album is
PONER OFF :

DISK SPACE on the docking cradle

[EEEE ) A

16



VERIFY

WIDEQ ON
oiok sehce | if the Digital Album is not
LN ey on the docking cradle

Use the navigation buttons 4 and w respectively to
scroll up or down through each of the menu items.

At the bottom of the LCD display, there is a status area
which displays various icons. A battery status bar
indicating the remaining power in the battery is also
present.

If no buttons are pressed on the unit for more than 15
seconds when the Digital Album is not on the docking
cradle, the unit immediately turns off as a powersaving
feature.

Each of the five options are explained as follows:

COPY

After inserting the memory card (e.g. CompactFlash,
Smart Media, Memory Stick etc)from the digital
camera, press the ® button. The contents of the memory
card will be copied into the hard disk. A status screen
will be displayed.

Flease Wait:
COFYIMG FILES
IM PROGRESS...

STRTUS: mEOO0O
[

17



Upon completion, the following is displayed:

CoPyY 0k

FLEASE FRESS
TO CONTIMUE
[

If the operation is not completed successfully, one of the
following messages will appear:

COPY ERROR - DISK FULL

To remedy this error, delete some pictures from
the Digital Album to free up more disk space.

COPY ERROR - CARD READ ERROR

To remedy this error, change another memory
card. The current one in use may be defective or
not supported.

VERIFY

This command is used to verify that the files have been
transferred from the memory card to the Digital Album
without errors. A status screen will be displayed.

Flease Wait:
VERIF%ING FILES
IM PROGRESS...

STRATUS: AEEEOO
[

18



Upon successful completion, the following is displayed:

UERIFY Ok

ERASE CHRD?Y

YES MO

Press the w button to clear the files from the memory
card and reset it for further usage. Press the 4 button to
preserve the current pictures on the card.

If the operation is not completed successfully, the
following message will appear:

LUERIFY ERROR
FLEASE FRESS
TO CONTIMUE
[

This message appears if the files last transferred to the
Digital Album do not match the files on the memory
card. To remedy this, insert the appropriate memory
card used in the last picture transfer and perform the
Verify operation again.

VIDEO ON

This option will not be available if the Digital Album is
not in the docking cradle.

Selecting this function will allow the contents of the
Digital Album to be viewed on the television and

19



manipulated through the remote control. Please refer to
Chapter 3 - Remote Control Functions for more details.

POWER OFF

Select this option and press ® to power down the
Digital Album. The Digital Album can also be shut off
by pressing the ® button on the remote control. Note
that the Digital Album, however, cannot be turned on
using the remote control.

DISK SPACE

Select this option to view the amount of remaining disk
space in the Digital Album. Push any button to return to
the Main Menu.

ADJUSTING LCD PANEL CONTRAST

To adjust the contrast of the LCD panel on the Digital
Album, press the D button once, and then select the
required level of contrast using the navigation buttons
Aand .

CHANGING VIDEO MODE

The Digital Album supports display in both PAL and

20



NTSC modes. To switch between the two, press the*
button. Select the required mode using the navigation
buttons 4 and w, then press the ® button.

For the change to take effect, power off the Digital

Album by pressing ® and then press ® again to power
up the unit (with the changed settings).

STATUS DISPLAY BAR

B DA =

At the bottom of the LCD panel, there are four status
indicators (also known as “annunciators”):

i  Battery power remaining

A Battery charging

= AC power adaptor connected
= USB is busy

Do not disconnect the USB or power down the Digital
Album when the = indicator is visible; otherwise, data
may be lost.

21



3. REMOTE CONTROL FUNCTIONS

he remote control contains 16 buttons which are

used:
! 1. ON/OFF
N 2. THUMBNAIL/
1 ' TEXT MODE
@ @ @ @ 3. AUTOMATIC
SLIDESHOW
a 3 4 MODE
@ @ ; 4. HELP
5 6 8 5. PULLDOWN
P20 | .
. 6. TAB
9 1 7. OK
» O ¢ wcas
9. ROTATE
10 169 14 10. ZOOM IN
@ ° 11. ZOOM OUT

© 0
°QJ

11 15 12. UP
| ° 13. LEFT
\ 14. RIGHT
', 15. DOWN
1
. o 16. ENTER
Disital
Al

ra

22



POWERING UP

To view pictures on the Digital Album, ensure that it is
connected to a television. When viewing on a television
set, select the appropriate video feed channel.

Turn on the Digital Album by depressing the® button
and selecting the VIDEO ON option. The unit will
power up, simultaneously displaying the welcome
message on the video screen.

Digital Album

Nixvue Svystems

This message initially appears as white text against a
dark background as the unit powers up. When it is
ready for operation, the text turns to amber and enters
File Menu in Text mode.
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The Digital Album can be operated in the following
modes:

Text Mode - This mode displays a list of all the filenames
and folders in the Digital Album, allowing the user to
navigate through and select from these items. To access
the pull-down menu, press the @ button.

@ Thumbnail Mode - This mode displays all the
pictures in a set of miniature images, allowing the user
to preview each set at a glance. This button can also be
used to toggle between Thumbnail and Text mode.

@ Automatic Slideshow Mode - This mode displays
each of the pictures in full screen, automatically
advancing to the next picture after a preset duration.

Manual Slideshow Mode - This mode displays each
picture in full screen, with the user able to toggle
forward or backwards to the picture after or before the
current one.

Each time a mode button is pressed, the Digital Album
enters that respective mode. If the mode button is
pressed a second time, the Digital Album toggles back
to the last selected mode.

24



TEXT MODE (FILE LIST)

From initial startup, press the ® button on the remote
control to activate Text mode. The following screen
appears:

File Edit Yiews options Help

aleph g S114 jpg
apple lrng =11 E..:lg
bBen Eanin
beth
bBrngs
daleth
ee enaj
eurcopewsind ey :  Si127F. pg
gimel NEXwLIe. g
TorZ. jpog

recycled bhin

il rendevous

BE shalom

arabian. jpog

copyl of img_S116.jpg

copyl of mg_ 51200 pg

copyl of img 5127 pg

d=scnD713. pg

gl 312 jpg

g 0235 g

g S511. jpag

Use the navigation buttons on the remote control * 4w
to move between each file or folder, and the ® button to
enter the selection.

Each time a download is performed, all the new pictures
will be placed into a new folder and numbered in
ascending order. These folders serve as a convenient
way to store a particular series of pictures, such as
pictures taken on a particular occasion or grouping a
particular category of images together.

25



More information about each of the pulldown options
in Text mode is given in the following chapter, Chapter
4 - Video Menu Functions.

THUMBNAIL MODE

Press @ on the remote control to view the pictures in
Thumbnail mode. The following screen appears:

File Edit YViews options Help

EuropeiyAnd IZ. 00K EBE AP

This allows the user to quickly view and locate a
particular picture. Each thumbnail can be expanded to
view in full-screen mode for greater detail. The name

26



and size of each highlighted file is also disphyed at the
bottom of the screen.

Use the navigation buttons on the remote control * 4w
to move between each picture or folder. If a picture is
selected, press the ® button to select and display the
picture in full size. If a folder is selected, press

the @ button to enter the folder.

MANUAL SLIDESHOW MODE

To enter Manual Slideshow mode, press the ® button on
the selected picture from Text or Thumbnail mode. The
chosen picture is then displayed in the full video screen.

Use the navigation buttons on the remote control 4»
respectively to move backwards or forwards between
each picture, and the @ button to return to the previous
mode.

To rotate the picture, press the @ button. Each
depression will rotate the picture clockwise 90 degrees.
The picture can also be enlarged or reduced respectively

. ) 2 .

with the O or O buttons. Each zoom increments or
decrements the size by a factor of two, up to a maximum
of two steps in both directions.
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AUTOMATIC SLIDESHOW MODE

Press the @ button to enter Automatic Slideshow mode.
All the pictures in the current folder are displayed in
tull size, in sequence at a pre-set interval.

The timing of this interval can be configured from the
Main Menu under the Options option at the following
intervals: 1 t 0 10, 15, 30, 45 and 60 seconds.

To end Automatic Slideshow mode, press the ® button
to return to the previous mode.

28



4. VIDEO MENU FUNCTIONS

MAIN MENU

The Main Menu can be accessed on the video screen by

pressing the @ button. Each of the following Menu
functions is described in turn.

MAIN MENU SUB-MENU AND FUNCTIONS
ITEMS
File Delete
Rename
New Folder
Print
Edit Cut
Copy
Paste
View Thumbnail or File List
Slideshow
Options Slideshow Interval
Empty Recycle Bin
Help About DA
Help
STATUS BAR

The status bar can be found at the bottom of the

application window.

29




=1 I i

" iEns—i:lElil—d..ilg |1_m]n|B | |

The status bar is used to display file and folder
information, such as the current selected file name and
file size.

FILE MENU

Eai  view

R enanme
Hew Folder

The File pull-down menu allows the user to execute
various functions related to file access and maintenance.

FILE MENU - DELETE

This option allows the user to delete a particular folder
or file. When a file or folder is deleted, it will be moved
to the Recycle Bin folder.
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DELETING A FILE

To permanently delete a file or folder, go to the Recycle
Bin. When a file or folder is deleted from theRecycle Bin,
the user will be prompted to confirm the decision.

Confirtn delete

Delete “"immg 0213, pg- <

Press ® to confirm. The file or folder will then be
permanently erased.

UNDELETING A FILE

To undelete a file, go to the Recycle Bin folder. Select the
file to undelete, select the Cut option under the Edit
menu, return to the folder in which the deleted file
should be restored and select the Paste option under the
Edit menu.
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FILE MENU - RENAME

Holidawy
Al B C D E F
o H 1 -1 [ L
i L5 4 o P Q R
s = L0 iy L nr =
Caps sl s 1 = 3 4
Shiftt = & F (i 9 o
Del O =-— —=
Eos—d30— 2. g 1.00MB

This option allows the user to rename a file or folder. A
pop-up box and character entry keypad will appear
prompting the user to rename the file. There is a file-
name limit of 256 characters, inclusive of alphanumeric,
period and underscores.

Using the remote control, navigate using the e and
“ 4r v buttons to select each letter of the alpha-
numeric set by pressing ®.

On the keypad, use[CAPS] to toggle whether the
characters are entered in upper or lower case. If the
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button is highlighted, then the characters will be ertered
in upper case.

For a one-time change of letter case, select [SHIFT]
followed by the required letter- it will appear in the
opposite letter-case.

To delete a character, position the cursor using the
[ <-]and [ ->] keys to the left of the character to be
deleted, then select [DELETE].

To escape this without effecting any change, press the

@ key on the remote control.

FILE MENU - NEW FOLDER

Mewr Foldar
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This option allows the user to create a new folder in the
current directory. A pop-up box will appear prompting
the user to enter a name for the folder.

The character name entry for folder creation is identical
to the one for file renaming described in the previous
section. Please refer to the above section File Menu -
Rename for more details.

FILE MENU - PRINT

This option allows the user to print a selected image,
when a printer has been connected. When the options
have been confirmed, select[ Print ] to print the image.

Print

——— Printer Hame —

EPSON Stylus Photo 870 |~ ]

[ Print to File Properties |

Humber of Copies: 1 =

Print | cancerl |

Printer Name - Select the appropriate printer from the
drop-down menu.
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Print to File - Select this box to create a print file with
the PRN extension.

Properties Button - Select this box to adjust the print
properties. Refer to the File Menu - Print (Properties)
section below for details.

Number of Copies - Select the number of copies to
print up keying the up and down buttons. A maximum
of 99 pages can be printed.

FILE MENU - PRINT (PROPERTIES)

This option allows the user to configure the
specifications for the printer.

Print Setup H2E

— Media Type
FPhoito Guahity Inkjet Paper H
—— Quality g
IBest - ] U tility I

—— Page Size

| AB 105=148mm = |
— Page Setting - [ Rotate by 180
¢ Portrait I~ Scale to Fit
= Landscape I~ Ccentered
oKk | cances |
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Media Type - Select the appropriate type of paper to
print on from the drop-down menu. The available paper
types supported are:

o Photo Quality Inkjet Paper
o Photo Paper
o Photo Quality Glossy Film

Quality - Select the appropriate print quality from the
drop-down menu. The supported levels of print quality
are:

o Draft
o Normal

o Presentation

Utility - Select this option to view the printer utilities
pop-up window.

Print Uiility H2E

Status Monitor
Mozzile Checlkc

Hezaui Cleaning

Print Head Adpprstiment

Cancel I
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The utilities available on the Digital Album will vary
from printer to printer. Please check the printer manual
for more details on the printer’s built-in utilities.

Page Size - Select the desired page size of the print
medium from the drop-down menu. The supported
page sizes are:

Letter

Legal

A4

Ab

A6

Higaki

Photo 4” by 6”

Photo Size 100 x 150 mm
Photo Size 200 x 300 mm

O O 0O 0O 0O O O O O

Page Setting - Select the required orientation of the
print by selecting either Portrait or Landscape.

Rotate 90° - Select this option to rotate the printed
image clockwise by 90°.

Scale to Fit - Select this option to scale the page to fit.

Centered - Select this option to center the picture on the
printed page.
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EDIT MENU

Edit

The Edit pull-down menu provides the user with
various functions related to text editing and
replacement. The familiar Windows functions of cutting,
copying and pasting text to the Clipboard are
duplicated here on this user interface.

EDIT MENU - CUT

This option allows the user to remove the selected file
from the active document and place it in the Clipboard.
The selected file is removed from its current location.

EDIT MENU - COPY

This option allows the user to copy the selected picture
file from the Main Menu and place it in the Clipboard.
The selected file is not removed from its current
location.

38



EDIT MENU - PASTE

This option allows the user to insert the current content
of the Clipboard into the current folder at the location of
the cursor.

VIEW MENU

The View pull-down menu allows the user select
between Thumbnail and Automatic Slideshow modes
when in Text mode, and between Text and Automatic
Slideshow modes when in Thumbnail mode.

VIEW MENU - THUMBNAIL

opuons

Thusmnisrsail it _:I:]li
Slide Shows ki

i=us—1.§

I=us=s—10.
I=us—11.
I=zus—Z2_§

This option is available only in Text mode. It puts the
Digital Album into Thumbnail mode, which displays the
photos as miniature images. This allows the user to
preview a set of pictures on one screen.
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VIEW MENU - FILE LIST

This option is available only in Thumbnail mode. This
option puts the Digital Album into Text mode, which
displays a list of files and folders in the current
directory.

VIEW MENU - SLIDESHOW

This option puts the Digital Album into Automatic
Slideshow mode, which displays the photos in sequence
at a pre-set interval.

To escape Automatic Slideshow mode, press the ® key on
the remote.

OPTIONS MENU

“opons [JET

Shdeshow Intervwal
Empiy recycled bhin

fxus— 1. 'i;tg
Iz=zus—10. o
Iz=zus—11. g

This Options pull-down menu allows the user to set the
time interval for Automatic Slideshow mode, as well as to
empty the Recycle Bin.
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OPTIONS MENU - SLIDESHOW INTERVAL

This option allows the user to set the time interval when
displaying pictures in Automatic Slideshow mode. The
adjustable time intervals are: 1 - 10, 15, 30, 45 and 60
seconds.

OPTIONS MENU - EMPTY RECYCLE BIN

This option will delete all the files and folders which
have been moved to the Recycle Bin by the File - Delete
command. Once the Recycle Bin is emptied, the deleted
files cannot be recovered.

HELP MENU

Obhwout DS

The Help pull-down menu provides the user with
online help and information on Nixvue Digital Album.
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HELP MENU - ABOUT DA

Copwright 2000

Mizxwvue Systems Pte Ltd.
Tel: (65) 5237 - 2410

Fritp: Fivr s s, il Ue. COorn

This option will display a pop-up window with Nixvue
Digital Album program information, such as program
name, copyright information, version number and the
licensee for the current version of the program.

HELP MENU - HELP

This option will display the online help file for Nixvue
Digital Album.
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5. TROUBLESHOOTING AND

SPECIFICATIONS

TROUBLESHOOTING

f you experience any of the following difficulties

while using the Digital Album, use this guide to help
you quickly remedy the problem. Should any problem
persist, consult your nearest authorized Nixvue repair

center.
SYMPTOM / REMEDY
PROBLEM
Digital Album 1. Connect the DA to the computer

operation appears to
be slower than usual

and run Scandisk (found in
Windows) on the DA.

2. Optimize the DA by running
Disk Defragmenter.

Printer does not
respond

1. Check that the printer used is one
of the specified models supported
by Nixvue. You may refer to the
website at:

http://www.nixvue.com
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SYMPTOM /
PROBLEM

REMEDY

No video image (or a
blue screen) is seen
on the monitor/
television.

1. Check that the video leads
between the DA and the screen are
connected properly.

2. The picture mode may be
selected wrongly. Select either PAL
or NTSC as appropriate. Refer to
Changing Video Mode in

Chapter 2 for details.

3. Remember to power the DA off
and on again after selecting the new
video mode.

DA cannot power up

1. Check that there is a full battery
charge in the DA. Even when
powered off, the DA still draws a
minimal current from the battery
that fully discharges in about 3- 6
months.

2. You may need to change the
battery. Please refer to your Nixvue
dealer.
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SPECIFICATIONS

Dimensions and weight:

Digital Album 146 x 82.5x29mm / 280 g
Cradle 157 x 113 x72mm / 260 g
Interfaces:
Digital Album PCMCIA
Cradle USB, Composite video,
Parallel, 5V DC input

Power Source:
5V AC/DC Adaptor
Standard Storage Capacity:
2.5” HDD, 10 GB (approx. 10,000 images)

Actual capacity may vary depending on country and
distributor options.

Operating Temperature:
0°to 40° C.
Shock Rating:

Do not s ubject the Digital Album to sudden impact
(up to 40 G -force).

Battery Rating:

30 transfers at 32 MB each (fully -charged)
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SEND US YOUR COMMENTS

Digital Album User’s Guide

Nixvue welcomes all comments and suggestions on the
quality and usefulness of this document. Our users’
feedback is an important component of the information
used for improvement of this document.

Please include in your feedback:

e Name and Title

e Company and Department
e E-Mail

e DPostal Address

e Telephone and Fax Number

Also, please include the chapter, section and/or page
number when referring to specific portions of the
document.

Comments can be sent to us in any of the following
media:

e internet: support@nixvue.com

e fax: (65) 546-2124

® post: Nixvue Systems Pte Ltd
30, Loyang Way, #07-02
SINGAPORE 508769

All comments should be directed to the Director,
Marketing.
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Limited Warranty (Outside US)

This product, excluding batteries, is guaranteed by
Nixvue for a period of one (1) year from the date of
purchase. It will be repaired or replaced with an
equivalent product (at Nixvue’s discretion) free of
charge for any defect due to faulty workmanship or
materials.

Products purchased outside the US that are returned
under warranty must be returned to the original vendor
with proof of purchase and description of the fault.
Charges will be enforced for all repairs unless
accompanied by proof of purchase.

This warranty explicitly excludes defects arising from
misuse, accidental damage or wear and tear. This
guarantee does not affect the customer’s statutory rights
in any way.

Limited Warranty (US Only)

Nixvue warrants to the original purchaser of this
product that the equipment shall be free of defects
resulting from workmanship or component defects for

a period of one (1) year from the date of purchase.
Defects covered by this Limited Warranty shall be
rectified either by repair or at Nixvue's discretion, by
replacement.  In the event of replacement, the
replacement unit will be warranted for the duration of
the original one (1) year period or thirty (30) days,
whichever is longer. THERE ARE NO OTHER ORAL
OR WRITTEN WARRANTIES EXPRESS OR IMPLIED
INCLUDING, BUT NOT LIMITED TO THOSE
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OR MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE.

This Limited Warranty is non-transferable, and does not
apply if the product has been damaged by negligence,
accident. abuse, misuse, modification, misapplication,
shipment to the manufacturer or services of someone or
agency other than Nixvue's authorized service centres.
To be eligible for warranty service, a defective product
must be sent to and received by Nixvue within fifteen
(15) months of the date of purchase and be accompanied
by proof of purchase. Nixvue does not warrant that this
product will meet your requirements. It is your sole
responsibility to determine the suitability of this product
for your purposes. Nixvue does not warrant the
compatibility of this product with your computer or
related peripherals, operating systems and software.

NIXVUE'S SOLE OBLIGATION AND LIABILITY
UNDERTHIS WARRANTY IS LIMITED TO THE
REPAIR OR REPLACEMENT OF A DEFECTIVH
PRODUCT. THE MANUFACTURER SHALL NOT, IN
ANY EVENT, BE LIABLE TO THE PURCHASER OK
ANY THIRD PARTY FOR ANY INCIDENTAL OR
CONSEQUENTIAL DAMAGES OR LIABILITY IN
TORT RELATING TO THIS PRODUCT OR
RESULTING FROM ITS USE OR POSSESSION.

This Limited Warranty is governed by the laws of the
Republic of Singapore.
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FCC Statement

This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:

e This device many not cause harmful
interference.

e This device must accept any interference
received, including interference that may
cause undesirable operation.

This equipment has been tested and found to comply
with the limits for a Class B digital device pursuantto
Part 15 of FCC Rules. These limits are designed to
provide reasonable protection against harmful
interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy,
and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio
communications.

However, there is no guarantee that the interference will
not occur in a particular installation. If this equipment
does cause harmful interference to radio or television
reception, which may be determined by turning the
equipment off and on, the user is encouraged to try to
correct for the interference by one or more of the
following measures:

e Re-orientate or relocate the receiving antenna.
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e Increase the separation between the device and
the receiver.

e Connect the device into an outlet on a circuit
different from that of the receiver.

e Consult with the dealer or an experienced
radio/ TV technician.

Shielded interface cables must be used in order to
comply with emission limits. Changes or modifications
not expressly approved by the party responsible for
compliance could void the user's authority to operate
the equipment.
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